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1   

1.1 About Wink™ 
 
Wink is a software tool to make presentations and tutorials about using software 
programs.  A Wink presentation will resemble a live walkthrough about how to use 
the software. Also  the author of the presentation can add comments and 
explanations to parts of the presentation to better explain the concepts and usage to 
the end user. 
 
There are many purposes for these kinds of presentations: 

• Advertising of software. 
• Tutorials of software for classes. 
• Documentation of software to supplement written documentation. 
• Answer questions about the use of programs visually. 

 
The basic output format of Wink is Flash. Flash is viewed in a web browser using the 
free Macromedia Flash Player which is already installed on most computers with the 
browser or can easily be installed the first the time the end user tries to watch a flash 
file. 
 
Wink is actively in development and constantly improving. If you have a comment or 
suggestion to make or an idea to improve, please make it public by posting in the 
UserForums at "http://www.debugmode.com/forums/". 
 

1.2 Requirements 
 
When working inside Wink the minimum screen resolution to be used should be 
800*600 to be able to see the entire simple properties bar. 
 
It is recommended though to use a screen resolution of 1024*768 or better to be able 
to see the entire advanced properties bar. It is also easier to edit a presentation in a 
larger screen resolution because you will be able to see full or at least a larger part of 
the current frame. 
 
The minimum and recommended screen resolution doesn't apply when you are 
capturing screenshots for the Wink presentation. These could very well be captured 
with a screen resolution of 640*480 depending on the needs. 
 

1.3 Installation 
 
The installation package comes as a zip file with the install files. Unzip this file into 
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any temporary folder and run "setup.exe" to start the installation. 
 

1.4 Using this guide 
 
This user guide is distributed as a PDF document so that it can be printed as a 
manual if necessary. It is recommended that you read this document completely 
before starting to use Wink so that you can work with ease. Also a printout of the 
shortcut keys will be helpful. 
 
Two tutorial projects are present in this distribution. Once installed, ru n Wink and 
choose menu "Help > View tutorial 1". This will ask if you want to render now, choose 
yes. You will be shown the tutorial soon after the rendering is done. 
 
The sample projects are named "tutorial.wnk" and "sample.wnk". These files are 
present in the Wink\Samples folder. There is also a step-by-step tutorial later in this 
document. 
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2   

2.1 How to use Wink 
 
To create a new presentation in Wink you run your target software and take 
screenshots of each action done in that software. These screenshots will afterwards 
be put together by Wink into a continuous movie in which each screenshot 
represents a frame. Frames can be moved, deleted and copied inside the project and 
between projects. 
 
The mouse cursor’s position is saved separately for each frame. This way Wink will 
take care of making the cursor move smoothly between frames. You can also change 
the position of the mouse cursor in any frame. 
 
There are several advantages to record  presentations using  screenshots and not 
recording the entire presentation as a single movie: 
 

• It is easier to capture screenshots because if you make mistakes (open the 
wrong file, do the wrong action, forget what to do and thereby making a long 
pause etc.) in the recording progress you just don't take screenshots of these 
errors. If you were recording a continuous file you would have to be very 
prepared in advance to avoid these kinds of recording mistakes. 

• When editing the file afterwards there are fewer frames to work with and most 
frames are important - that is to say that there are only few or none 
intermediate frames that for instance just show the mouse cursor moving from 
one place to another. 

• The resulting flash file will also be smaller because there are fewer frames in 
the presentation. 

 
But in some cases it can be useful to just record everything that happens e.g. when 
drawing or typing text in a program. In this case Wink can be set to continuously take 
screenshots with a certain frame rate. 
 
After the recording is done you can edit the sequence of frames and add 
comments/explanations to each frame as necessary. You can add Previous and 
Next buttons to pause the presentation and the user can then go back and forward in 
the presentation by clicking these buttons. You can also add two Goto buttons that 
jumps to other sections in the presentation. These  help to create more advanced 
presentations with different flows through the content instead of just going from start 
to finish. 
 
You can customize/personalize the presentation by choosing a static background 
image for the entire presentation. This can contain the name, logo, copyright 
messages etc. of the author and/or company. 
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In order to make consistent presentations you can create templates based on one 
presentation and then apply this template to all other presentations. This way it is 
easy to get the same look across presentations and you don’t have to do the same 
customizations each time. 
 
Once you have finished creating and editing a presentation, it must be rendered to a 
flash file that for instance can be placed on a website or distributed for the end 
users/customers to see. The quality and size of the presentation can be adjusted 
through the number of colors used and the chosen frame rate of the flash file. 
 
The presentation can also be exported to a html or pdf file. These exported files can 
be placed together with the rendered flash file on a website and the end user will 
then have the option to print the presentation. Each frame in the presentation will 
become a single image with the comments/explanations and buttons that have been 
added in Wink. All buttons will still work in the exported files and will jump to the 
corresponding place (html) or page (pdf) in the file when clicked.  
 

2.2 Your first Wink project step-by-step 
 
This section will guide you through the process of making your first Wink project. We 
will make a short presentation that shows how to change the view in Windows 
Explorer from the icons to details. You can also find a Wink project for this tutorial 
named “tutorial.wnk” in the folder ”Wink\Samples”. 
 
1. First open Windows Explorer because this is the program we want to show in the 

presentation. Now start Wink and create a new project using menu FileàNew. 
This brings up a wizard that by default sets Wink to capture screenshots of the 
entire screen. One of the options in this step is to change the capture region to a 
specific window or part of the screen (rectangle). For this project we will capture 
the region of the Explorer window so choose the window option. Click the ”Hide 
Wink Window” checkbox to make the Explorer window visible. Afterwards click 
the Choose button, move the mouse to the title bar of Windows Explorer and left 
click to select this window. Press OK to continue to step 2. 

 
2. Minimize Wink to the sysem tray (to the right hand corner of screen) by pressing 

the minimize button in the "New Project Wizard" window and we can now take 
screenshots by pressing the "Pause" key. Each time you take a screenshot the 
Wink icon in the system tray will blink. 

 
3. Take screenshots after each of the following actions in Windows Explorer: 
 

3.1 Minimize all windows except Windows Explorer. Place the mouse cursor 
somewhere in Windows Explorer. Take a screenshot. 

 
3.2 Move the mouse cursor to the “View” menu in Explorer. Take a screenshot. 
 
3.3 Open the menu by left clicking. Take a screenshot. 
 
3.4 Move the mouse cursor to the “Details” menu option. Take a screenshot. 
 
3.5 Click the mouse to select the Details option. This changes the view to details 

view. Take a screenshot. 
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4. Now we have finished capturing frames so right click on the Wink icon in the 
system tray and choose "Finish Capture". 

 
5. Wink will now be displaying the current project. The larger top part of the window 

shows the last frame in the sequence. In the bottom you can see all frames in the 
sequence/presentation. The captured mouse cursor is visible with a box around it 
to easily identify it from the real cursor. In the other frames you will be able to see 
the progress of the presentation and the movement of the cursor. 

 
6. First we will add a textbox to the first frame explaining what this presentation 

shows. For each frame the text is displayed in a popup balloon-like window called 
the Callout. A Callout is a group of shapes created using the in -built Callout 
Editor tool. Wink comes with many pre-defined Callouts for you to use for 
displaying text balloons in frames, and you can create your own Callouts using 
the Callout Editor. 

 
7. Select the first frame in the thumbnail list shown at the bottom of the window. 

Now go to the Properties bar (the bar on the right of the Wink window) and 
enable the checkbox named Textbox. The textbox will be displayed with a default 
Callout in the frame. You can now type the text (something like "How to change 
view in Windows Explorer") and the text will simultaneously be displayed in the 
frame’s Callout. You can resize the callout in the frame, move it to another 
position, choose another Callout by clicking the button to the right of the current 
Callout and edit the font by clicking the button to the right of the current font. 

 
8. Now we will add a Next button that the end user can use to navigate the 

presentation and a Goto button to return to the start from the last frame (in this 
simple presentation a back button would also return to the first frame). Select the 
first frame in the sequence and click the checkbox for the Next Button in the 
properties bar. The button is by default placed in the bottom right corner but it can 
be moved to any place you desire. 

 
9. Select the last frame and click the checkbox for “Goto Button 1”. Then click the 

choose button next to the checkbox to select the frame it should go to. In this 
case is should be frame 1. Goto buttons are by default placed in the top left 
corner but can also be moved anywhere in the frame. You can move this Goto 
button to the center of the frame area. 

 
10. To tell the end user what this Goto button do, we will add a text box to this frame 

with the text “Replay presentation”. The text box and the Goto button should be 
placed so that the button is inside the text box area either to the right of or below 
the actual text. 

 
11. Choose menu ”ProjectàSettings”. Type the name for the output flash file (for 

instance "Explorer_views"). If you just specify a filename, the output flash file will 
be saved in the directory where the project is saved. Press OK when you have 
typed a name. 

 
12. Before rendering the presentation we will save the project  using the menu 

”FileàSave”. You should save your project often when editing the project. 
 

13. Choose menu ”ProjectàRender” to create the presentation as a Flash file. 
 

14. Congratulations - you have made your first Wink presentation. 
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15. Go to Windows Explorer and view the directory where the flash file was saved. 
Besides the actual flash file Wink also generates a HTML file with the same name 
to open the flash file in the correct size. Open the html file in your browser and 
you should see the presentation being displayed or if you have not installed 
Macromedia Flash Player you should be transferred to a site where this player 
can be installed. Your new presentation will automatically play through all the 
frames. 

 
You have now seen and tried some of the options in Wink. Continue reading the next 
chapter to get more information about the user interface and options in Wink to 
improve your skills in making great Wink presentations. 
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3   

3.1 Basic UI 
 
When you first start Wink you will see a menu and a toolbar at the top of the window. 
To the right is the Properties bar where individual and common properties for all 
frames are accessible. The properties bar can be changed between a simple 
(default) and an advance d view through the menu “ViewàProperties Bar”. The 
difference between simple and advanced view is that in advanced view it is possible 
to see and edit the exact position of all elements added to a frame. 
 

 
 
The project window is divided into two parts: 

• In the work area at the top you see the currently chosen frame in normal size 
and the elements that are added to the frame can be moved and resized with 
the mouse. 

• The thumbnail list at the bottom shows thumbnails of all the frames in the 
current project. You can drag-and-drop frames within this list or between 
projects and select which frame you want to edit in the work area. 

 
More than one project can be open simultaneously in Wink, which makes it possible 
copy frames between projects.  
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3.2 New Project Wizard and capturing screenshots  
 
3.2.1  Step 1 - Setting up the project 
 
When creating a new project you will see the "New Project Wizard" with options to 
start capturing screenshots or just create an empty project. You can use the settings 
button to initialize the new project. 
  
Normally you would want to capture screenshots for the new project through Wink. If 
you just want an empty project you must disable the checkbox for "Start by capturing 
Screenshots". An empty project is useful if you want to copy frames from other 
existing projects or if you already have captured screenshots as single images with 
another program and now want to use them as the basis for the Wink project.  
 

 
 
When capturing screenshots with Wink there are 3 options for the area that should 
be captured in each screenshot: 
 

• Screen: The entire area of the current screen. 
• Rectangle: Use the Choose button you draw a rectangle around the area that 

must be captured. 
• Window: Use the Choose button and a rectangle will show the area of the 

window/program being captured. If you want to capture an entire window you 
should move the mouse cursor to the window’s title line. 

 
To easily identify the area that should be captured for the project you can click the 
"Hide Wink Window" checkbox. This will not hide the New Project Wizard dialog. It is 
also possible to enable Timed Capture. This will capture continuous screenshots with 
a certain number of screenshots per second as specified in the Capture Frame Rate 
field.  
 
When doing the actual capturing the Pause key will take a single screenshot and 
Shift + Pause will start/stop capturing continuous screenshots (Timed Capture). 
 
Press OK to go to Step 2 of the New Project Wizard (if you have chosen to capture 
screenshots). If you deselected the checkbox for "Start by capturing Screenshots" 
you will be brought back to Wink and see an empty project. 
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3.2.2  Step 2 - Capturing screenshots 
 
Wink is now in capture mode. You can see the hotkeys available to take screenshots 
and if checked earlier Timed Captures. In the bottom of the dialog you can see how 
many frames have been captured until now. 
 

 
 
In most cases you would now want to minimize Wink to the system tray so that Wink 
itself isn't visible in the screenshots. 
  
When minimized Wink capture is shown as an icon in the system tray. You can right 
click this icon to capture a screenshot, finish the capture session, cancel the capture 
session or restore the capture window (to see how many frames have been 
captured). 
 
When taking a screenshot by pressing the hotkey or through the right click menu 
mentioned above the Wink icon will blink momentarily. If you have enabled Timed 
Capture and press the hotkey to start this feature the Wink icon will be replaced by 
an animation that runs as fast as the number of frames per second specified in the 
"Capture Frame Rate" field earlier. 
 
When you are finished with capturing screenshots you must right click the Wink icon 
in the system tray and choose Finish (or Restore Capture Window and press the 
Finish button here). This will end the capture se ssion and you will see the project 
window. It might take a little while to generate all the thumbnails depending on the 
number of frames and the speed of your computer. 
 
If you choose to cancel the capture session no new project is created. 
 

3.3 Project Settings 
 
Project Settings can be opened through the menu “ProjectàSettings”. 
 
In the first field you must specify the name of the output flash file  to create when you 
render the project. If only a file name is specified the file will be created in the 
directory of the project file. 
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Output file type can be Macromedia Flash (.SWF) to present in web pages, or a self 
playing Flash executable (.EXE) which you can view directly in any PC. 
 
Frame Rate determines the speed of the presentation in frames per second. This 
setting is highly related  with the Cursor Movement setting. So if you want smoother 
cursor movement and move the slider to the left you will also have to increase the 
frame rate to make the mouse cursor have the same speed in the final presentation 
as the original setting. For a more thorough explanation see the gray box below 
about the connection between Frame rate and Mouse Cursor Movement. 
 
The last option specifies if the project should use a Palette when generating the flash 
file. Without using a palette the presentation will use all the colors seen in the 
individual frames. By adding a palette Wink reduces the total number of colors used 
throughout the presentation to a maximum of 256 colors. (You can define the number 
of colors in a palette to be between 1 and 256 colors.) 
 
The purpose of reducing the number of colors is to reduce the file size of the 
rendered flash file. Dependent on the number of colors in the frames you might not 
be able to see any difference in the rendered presentation than if not using a palette. 
If there are photos or gradients between colors in any frames the effect of using a 
palette will be more visible in the presentation. The creation of the actual palette is 
shown in the next section. 
 

The connection between Frame rate and Mouse Cursor Movement 

If the mouse cursor moves from one position to another between two frames, Wink will 
generate intermediate frames while rendering to show the cursor movement. A Cursor 
Movement is setting of (smooth) will generate more intermediate frames. But if we add more 
intermediate frames (by setting the Cursor Movement to be smooth) and don't increase the 
frame rate correspondingly the movement of the cursor in the flash file will also be slower. 
 
For instance if Wink normally generates 16 intermediate frames between 2 frames in the 
project and we use the default frame rate of 8 frames per second it will take 2 seconds for the 
cursor to move from the start position to the end position. If we now change the Cursor 
Movement to be smoother Wink may now generate 32 intermediate frames between the 2 
original frames. With the default frame rate of 8 frames per second it will now take 4 seconds 
for the cursor to move from the start position to the end position. If we want the final 
presentation to keep the same speed as with the original smoothness setting we will have to 
change the frame rate to be 16 frames per second instead. 
 
This connection is described in this simple formula: 
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Frame rate / Smoothness of cursor movement = Speed of mouse cursor in presentation 
 
Higher frame rate à  Faster mouse cursor 
More smooth cursor movement à  Slower mouse cursor 

 

3.4 Palette  
 
If you have chosen to use a palette in the Project Settings you can create or edit a 
current palette by choosing menu “ProjectàEdit Palette”. Also if you have chosen to 
use a palette but have not created one before trying to render a flash file you will be 
shown this dialog. For best results postpone the palette creation until all editing in the 
project is done. 
 
The first time you will see an empty palette. You change the number of entries and 
choose each color manually but that is not recommended. Click the "Create New" 
button and let Wink create the palette from one of the 3 methods. 
 

 
 

• Windows Standard 16 color palette: If you want to support old systems that 
can only show 16 colors. 

• Standard Web-Safe 216 color palette: If you want to support users with 
systems that only show 256 colors concurrent on the screen. Actually if end 
users have their system set to 16 bit colors you can be 100% sure that they 
will see the same colors in the presentation you see when this setting is used. 

• Optimized Octree quantization: This is the recommended setting to use as 
this will be based on the actual colors in the current frame(s) and most end 
users will be able to see the presentation correct. You can choose how many 
color entries should be in the palette and if you want it to be based on all 
frames in the project or only the current frame. The default setting of 256 
entries and the option to base the palette on all frames should be the best 
setting in almost any case. It might take a little while to generate the entries 
with these settings. 

 
When the palette is created you can edit the individual colors by double clicking 
them. This can in some cases be necessary if one or a few colors in the generated 
presentation looks wrong. 
 
You can also save and load palettes. This can be useful if you are trying to see the 
effect of different palettes in the rendered presentation. 
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3.5 Editing frames in a project 
 
 
Most of the time spend in Wink will be 
used to edit frames in the project i.e. 
adding/removing elements to the frames.  
 
Almost all options regarding this are 
available in the properties bar (Some are 
also available in the menus and a few are 
only available through the menus). The 
properties bar can be displayed in a 
simple or advanced mode through the 
menu “ViewàProperties Bar”. In 
advanced view it is possible to see and 
edit the exact position of all elements 
added to a frame. Advanced view also 
enables you to edit/align the position of 
elements across multiple frames at once. 
See the Tips and Tweaks chapter on how 
to achieve this.  
 
To be able to see the entire properties bar 
in advanced view you have to use a 
screen resolution of 1024*768 or better. 
You only need a screen resolution of 
800*600 to see the entire simple 
properties bar. 
 

 
 
3.5.1  Frame Titles 
 
Frame titles are used to display a title/headline for individual frames. They can be 
enabled / disabled  for all frames using  the checkbox in the common properties 
section of the properties bar. You can change the font used for titles using the 
choose button (next to the font name) and alignment of the titles using the alignment 
button (next to the choose button). 
 
The actual title for the current frame is typed in the Title field of the properties bar. By 
default the field for the frame title field is placed in the top left area of the frame (50 
pixels to the right and 50 pixels down from the top left corner) and you can move and 
resize it as you need. Titles appear in the same position in all frames. 
 
If you haven't typed a title for the current frame you will see the text -”The frame's title 
will come here...”. This default text will not be displayed in the rendered flash file. 
 
3.5.2  Stay in this frame for time 
 
This field is used to add a pause before switching from the current frame to the next 
in the sequence. When adding small pauses between frames it gives the end user a 
little more time to comprehend what is being shown in a presentation and it can also 
be necessary to make the presentation look more real. 
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The pause is specified in milliseconds so a value of 1500 means 1.5 seconds. 
 
3.5.3  Cursor 
 
When capturing screenshots using  Wink the mouse cursor is displayed in the correct 
position for the individual frames. To make it easy to separate the actual mouse 
cursor from the cursor in the frame the latter is surrounded by a little box. You can 
move the cursor anywhere and enable / disable it as you need . 
 
You can change the cursor image in a frame using the choose button to the right of 
the cursor option in the properties bar. Here you will be able to choose from all the 
pointers in the currently used pointer scheme (This can be changed in Windows 
Control Panel) and user defined pointers. 
 

 
 
You can crea te new cursor images by selecting  an existing cursor and clicking the 
Create Copy button. Afterwards you can edit the new cursor by clicking the Edit 
button that will lead you to a small but full featured Cursor Editor. 
3.5.4  Cursor Editor 
 
When opening the Cursor Editor you will see the current cursor image. The most 
prominent part of this window is the work area that shows a zoomed view of the 
current pointer. At the top of the window are the tools you work with and on the right 
side you see on top a normally sized view of the current pointer and below the 
currently chosen and all available colors. 
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When drawing there is a color attached to each of the left and right mouse button, so 
you can choose and draw with different colors for each of the two buttons. The white 
box with a small cross represents “transparent” color. 
 

General tools  Drawing tools 

 Save the current cursor Enter   Freehand drawing P 

 Cut the entire cursor Ctrl + X   Erase, replace background  Ctrl + E  

 Copy the entire cursor Ctrl + C    color with foreground color  

 Paste the entire cursor Ctrl + V   Fill the area F 

 Undo last action Ctrl + Z   Draw lines L 

 Delete entire cursor Delete   Rectangle R 

 Inverse all colors  I   Filled rectangle Shift + R 

 Mirror the cursor Ctrl + F   Ellipse E 

 Flip the cursor Ctrl + M   Filled Ellipse Shift + E 

 
3.5.5  Next/Previous Buttons 
 
When a Next and/or Previous button is displayed in a frame the presentation will 
pause and the user has to click one of the buttons to continue. This gives control to 
the users and enables them to go through a presentation at their own pace. 
 
A Next button will continue directly to the next frame in the sequence while a Back 
button will go back to the last frame with any type of button. 
 
Like the other elements in a frame you can enable/disable each type of button by 
clicking their checkboxes in the properties bar and by default they are placed in the 
bottom right corner of the frame. They can be moved by dragging them around in the 
frame or by editing their p osition values in the advanced properties bar. Furthermore 
the buttons can be placed in different positions on each frame. 
 
You can use your own images for the buttons by clicking the second (Next) and third 
(Previous) button at the bottom of the properties bar (or through the Project menu) to 
change the images. A lot of formats are supported for the buttons including PNG -
images and icons where you can have transparent areas with full alpha channel to 
enable the use of cool looking buttons. 
 
Each button can only have one image that is common for all frames. 
 
3.5.6  Goto Button 1 and 2 
 
The two Goto Buttons can be seen as general-purpose versions of the Next/Previous 
Buttons and you decide which frame the Goto Buttons should jump to. This enables 
the creation of mo re complex flows though a presentation than just a linear flow from 
start to finish. 
 
If in your presentation you are showing two ways to do a particular action, you can 
take screenshots of both ways and give the end user the option to choose which way 
he/she wants to see. 
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Another use would be if there is both some basic knowledge and more advanced 
knowledge in a presentation. Here it would be possible to make the option to jump 
directly to the advanced knowledge if the user already knows the basic stuff.  
 
Finally when reaching the end of a presentation it would be obvious to create a Goto 
button that goes back to the first frame and in this way becomes a restart button. 
 
Each time you use a Goto button it is recommended that you refer to it from a textbox 
to tell the end user what it does. See examples of this in the included tutorial and the 
sample file. 
 
When adding a Goto button by clicking the relevant checkbox it will by default be 
placed at the top left corner where you can move it to the correct place. You tell it 
what frame to go to by clicking the choose button next to the chosen Goto Button (or 
through the Image menu) and select the correct frame. 
 

 
 
Like with the above mentioned Next/Previous Buttons you can also change the 
(common across all frames) image used by each Goto button. Here you do this by 
clicking the fourth (Goto 1) and fifth (Goto 2) button at the bottom of the properties 
bar or through the Project menu. 
 
3.5.7  Textbox 
 
Textboxes are often the most important element in a presentation because it is 
through these you increase its value by adding comments and explanations to the 
content in the individual frames. 
 
A textbox consists of a Callout and the actual text. The Callout is the graphical 
element the text is placed inside and it can be anything from a plain rectangle to 
fancy speech bubbles. A few standard Callouts are supplied with Wink but otherwise 
it is possible to design your own callouts with the Callout Editor. 
 
You can add/remove a textbox in a frame by clicking the checkbox in the Properties 
Bar. A new textbox uses a default Callout (the first one in the Callout Editor’s list). 
You can type in the textbox field in the properties bar and it will immediately be 
shown in the actual frame’s textbox. 
 
The textbox can be moved / resized using the mouse or by editing the position values 
in the advanced properties bar. You can change the Callout using the choose button 
to the right of the current Callout in the properties bar (or Choose Callout in the 
Image menu). This opens the Callout Editor where you can choose between the 
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Callouts in the left side and click Select to use the chosen Callout. 
 
The font used in the textbox can be changed using the choose button to the right of 
the current font in the properties bar (or Choose Font in the Image menu). Finally the 
alignment of the text in the textbox can be altered through the text align button in the 
properties bar. 
 
Textboxes can be copied between frames but if you paste in a frame which already 
has a textbox, the existing one will be replaced with the new properties. 
 
Frames with textboxes should be accompanied by Next/Previous (and/or Goto) 
buttons so that the presentation will pause at this frame and the user can decide 
when to continue. You can also specify a value in the ”Stay in this frame for time” 
field instead of using any buttons but this is not recommended as it not very flexible 
for the end user. 
 
3.5.8  Callout Editor 
 
The Callout Editor is accessible from the properties bar or menu “ImageàChoose 
Callout”. This is a pretty advanced too l to choose Callouts for your textboxes and to 
design your own Callouts. It might take a little while to grasp  the Callout Editor but 
when you have learned how to use it you can make all kinds of fancy looking 
Callouts. 
 

 
 
At the left side is a list of all the available Callouts. The first one is the default Callout 
used when you add a new textbox to a frame. You can change the default Callout by 
moving them up and down with the arrow buttons above the list.  
 
To create your own Callouts you can start with a new blank Callout by pressing the 
“New...” button or you can choose an existing Callout and click the “Save as New” 
button. Callout names must be unique so you must change the name before using 
the “Save as New” button. 
 
When you select a Callout you can view it in the work area and a list of all the 
elements in the Callout at the right side. If you select an element in this list it will also 
be selected in the work area and you can see the element properties below the list 
and modify them. Elements can also be selected directly in the work area. 
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To draw new Callouts Wink provides 5 different tools. 
 

 Rectangle - To create a rectangle shape click on a place in the work area, 
drag the mouse and release the mouse button in the second position. 

 Ellipse - Drawing an ellipse is similar to drawing a rectangle. 

 Polyline - Using this tool you can create a shape by drawing a set of 
connected lines. To start drawing click a place in the work area and the 
first line starts. Move the mouse to the second position and click, this will 
end the first line and start the second line from this position. Do this 
repeatedly until you have created the entire shape. To finish drawing the 
shape, click the right mouse button. 

 Freehand - This is the most useful tool for d rawing a shape. This tool 
allows drawing any kind of shape and creating the shape as a curve. You 
can modify this curve later as you want. To draw a freehand shape click 
on a place in the work area and draw the full Shape while keeping the 
mouse button pressed, and release the button after you have finished 
drawing. 

 Fill - The fill tool is used to fill the entire Callout or an area enclosed by the 
shapes that can be drawn with the other tools. 

 
Each shape has 3 properties: color, width and style (solid, dashed or dotted) of the 
line. Style only applies when the width is set to 1 – otherwise it can only be solid. 
These properties are set for new shapes through the last three options on the second 
toolbar. The properties of current shapes are changed by se lecting a shape and 
editing the shape properties in the bottom right corner. For fill elements only the color 
property applies. 
 
The elements will be added to the list in the order as they are added to the Callout. 
This order is important to get the correct effects. Latter elements in the list are drawn 
on top of earlier elements in the work area which will be pretty obvious with the 
shape elements but it also applies to fill elements. A fill element is only limited by 
shape elements created before it (otherwise it would fill the entire work area). 
 
The first element (TextField) in the list is special since it is only used to specify where 
text can be written inside the Callout. The only thing you do to this element is to 
change its position and size in the Callout. It cannot be deleted. 
 
There are two types of shapes: shapes created with lines and shapes created with 
curves. Polyline and rectangle are shapes created with lines while ellipse and 
freehand shapes are curves. A line -based shape has end-points, whereas a curve 
shape has control-points. 
 
Wink provides four tools to modify the shapes. 
 

 Edit - This tool allows editing a shape at the basic level, by modifying the 
points of the shape. If the shape is a line shape (i.e. a polyline or a 
rectangle), you can edit the end-points of each line. If the shape is a curve 
(ellipse and freehand), you can edit the control points of the curve. 
 
You can add new points to existing shapes simply by double clicking the 
line or curve where the new points should be added . Existing points are 
deleted by selecting a point on the line/curve and then pressing the delete 
key or icon. 
 



 21 

 Transform - This tool can move/resize/rotate one or many shapes. Just 
select all the shapes you want to edit, and use the controlling frame 
around the shape to move/resize the shapes. The following modifier keys 
can be used while dragging with the mouse: 
Shift key: resizes the shapes equally in horizontal and vertical directions. 
Ctrl key: creates a copy of all selected shapes. 
Alt key: each shape is resized with respect to its own center. If Alt key is 
not pressed and multiple shapes are selected, all shapes are resized with 
respect to their common center point. 
 
You can rotate the selected shapes by clicking on the (o) icon shown for 
each shape. This icon is present at the end of a line called the rotate 
handle . You click on the rotate handle and move the mouse to rotate the 
shapes. Pressing the Shift key while rotating will cause the shapes to be 
rotated around their own centers instead of the  common pivot point. 
 

 Mirror - This tool mirrors the selected elements. When no modifier key is 
used the selected elements are mirrored with respect to the work area’s 
center. 
Ctrl key: when multiple elements are selected, each element is mirrored 
with respect to its own center. 
Alt key: when multiple elements are selected, they are mirrored with 
respect to their common center. 
 

 Flip - This tool flips the selected elements. When no modifier key is used 
the selected elements are flipped with respect to the work area’s center. 
Ctrl key: when multiple elements are selected, each element is flipped 
with respect to its own center. 
Alt key: when multiple elements are selected, they are flipped with respect 
to their common center. 

 
The default color of the text in a Callout is set using the color button  in the middle of 
the second toolbar. This color is overridden if you choose another color in the font 
dialog for the individual textboxes. 
 
You can also  copy elements between Callouts if you want to reuse existing shapes. 
 
3.5.9  Background Image/Color 
 
The purpose of adding a background image or background color is to further 
customize the presentation to your needs. You can have a logo, name or copyright 
notice showing all through the presentation or add a background that looks like a TV 
set and use Next/Previous buttons as the TV's controls while showing the actual 
presentation on the screen. 
 
A background image or color is added to the presentation using the menu “Projectà 
Choose Background Image”. You can choose between a simple solid background 
color or load an image file created in another program. 
 
When using a simple color background you must specify how large the background 
area must be and the fill color. The size of the background area must be at least the 
size of the frame images in the project. Information about the size of the frame 
images can be found through the menu “ProjectàInformation”. 
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After having added a background image/color you will notice that the frame images in 
the project will by default be  placed at the top left corner of the background 
image/color. To change this position you can drag the frame image by its borders or 
edit the Frame Position values in the advanced properties bar. 
 
If you want to remove a background image/color from a project you just have to 
uncheck the checkbox for this option in the properties bar. Be aware that this 
removes the background from the project and does not just disable it. If you want the 
background back at a later time you have to choose the color or load the original 
image again in the Choose Background Image dialog. 
 
3.5.10   Shift All Elements 
 
If all elements in a number of (or all) frames have to be moved to another position 
use the “ImageàShift All Elements” dialog. You specify by how many pixels all 
elements (including the frame image/screenshot) have to be moved. This option is 
only available when a background image/color is used in the project. 
 
3.5.11 Crop frames 
 
Crop means you remove part of all frames in the current project e.g. if you have 
created a project based on screenshots of the entire screen, you might want to 
remove the bottom part showing the taskbar. Use the “ImageàCrop Frames” dialog 
for this purpose . 
 
The dialog displays the current size of frames in the project. You specify the area to 
which you want to crop the frames. If you use a background image/color in the 
project Crop Frames won’t affect the background but only the frame 
images/screenshots. 
 
3.5.12 Insert and delete frames 
 
New frames can be inserted in a project by menu “ImageàInsert Frames”. You can 
insert frames before or after the currently selected frame and they can either be a 
copy of the current frame or blank frame s (used to paste images/screenshots created 
by other programs). When inserting blank frames into an empty project you will be 
asked for the size of the frames to insert. 
 

 
 
You can delete selected frames using the delete key/icon or going through the menu 
“EditàDelete ”. 
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3.5.13 Editing the sequence of frames 
 
You can use standard drag-and-drop, cut, copy and paste tools to work with the  
frames in the thumbnail view of the project.  
 
When you copy a frame in the thumbnail view, all the  elements (frame, buttons, 
textbox, title etc.) are copied and when pasted it will create a new frame. 
 
There is another option called Copy Merged in the Edit menu. This will merge the 
frame and all elements into a single image. If you paste an image that has been 
created by the Copy Merge option this image will not create a new frame but the 
image will be inserted into the current frame and the elements will not be editable any 
more as they are a part of the image. The purpose of Copy Merge is to copy an 
entire frame with added elements to other programs like an image editor or word 
processor. 
 
3.5.14 Thumbnails Only View 
 
When there are many frames in a project it can be useful to switch to the 
Thumbnails -Only view through the menu “ViewàThumbnails Only” (or by double 
clicking one of the thumbnails in the sequence). Here you get an overview of the 
entire project and it is easier to edit the sequence of frames. It is also an easy way to 
find a specific frame you want to edit. You return to the normal project view through 
the same menu option or double clicking a thumbnail. 
 

3.6 Rendering the flash presentation 
 
To create a flash presentation use menu “ProjectàRender”. If you haven't named the 
output file yet in the Project Settings the dialog will popup first for you to give the 
name. Also if you have chosen to use a palette but haven't created one yet, the 
palette dialog will be shown for you to do this before starting to  render.  
 
Rendering creates a flash .swf file and a corresponding HTML file (in the same 
folder). To view the presentation open the HTML file in your browser and it will play 
the flash in correct resolution. 

3.7 Templates 
 
One of the advanced features of Wink is the option to create templates with many of 
the settings/properties that apply to a project. You can use templates to make 
consistent presentations with the same look without having to do the same 
customizations each time. 
 
Not all settings/properties can be saved in a template because some settings will 
seldom or never apply to all frames in a project or to more than one project. In the 
schema below you can see which item can be saved and which that cannot be 
saved. 
 

Items that can be saved Items that cannot be saved 
Background Image Title Text 
Frame Position Stay in this frame for time 
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Title Enabled Cursor Enabled 
Title Font & Style Cursor Pointer 
Title Position Cursor Position 

Callout Next Button Enabled 
Textbox Font & Style Previous Button Enabled 
Next Button Position Goto Button 1 Enabled 
Previous Button Position Goto Button 1 Target 
Goto Button Positions Goto Button 2 Enabled 

Next Button Image Goto Button 2 Target 
Previous Button Image Textbox Enabled 
Goto Button Images  Textbox Text 
Frame Rate Setting Textbox Position 
Use Palette Setting Actual Palette 

Cursor Movement Setting Output file name 

 
Templates are created based on the settings of a chosen frame in the project so 
when you want to create a template you first have to find (or create) a frame with all 
the correct settings. Then use menu “FileàSave Project Template”. This opens the 
choose dialog where you select what items to save in the template. By default all 
items are selected. Press OK and a Save dialog will appear to specify the template 
file name. Templates are by default saved in the “Templates” subfolder in the Wink 
installation folder. 
 

 
 
Later when you want to apply a template to a project (to all the frames) use menu 
“ProjectàApply Template ”. This will show the templa te choose dialog. Choose the 
template file to see a preview of the current project with the selected template. To 
select which template items to apply you can use the “Choose template items” 
button. 
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Be aware that all position items from a template are based on the size of the frame 
image in the original project from which the template  was created. So applying a 
template to a project with different frame sizes may not produce neat results and 
some elements might even be placed outside the viewable area of the frame if the 
size of the current project is much smaller than the original project. Templates works 
best if they are applied to projects with frame s of the same size as the project the 
template is created from. 

3.8 Export to HTML, PDF and image files 
 
Wink can export the project to a HTML or PDF file. This gives you an easy way to 
present the subject to your end users in a format other than the flash presentation. 
For instance some users may want to print the presentation, which isn't possible with 
a flash file. If a HTML or PDF file is placed next to the flash presentation on a website 
the users have more options. 
 
The images in the exported HTML/PDF file will look exactly like the frames in the 
project and the buttons will still work in both the HTML and PDF format. 
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To export use menu “FileàExport to HTML” or “FileàExport to PDF” options and 
specify the path/filename. When exporting to a HTML file you also have to choose 
the format used for each image (the images are saved as separate files). Be aware 
that you must only use BMP, JPG or PNG formats if you want to be able to see the 
images in the HTML file. The other image format options are available for situations 
where you want to work with the images in other image editors. 
 
The best image format fo r HTML files is usually Portable Network Graphics (PNG) 
regarding size and image quality when working with screenshots of programs. If 
some of the frames in the project contain photos then try JPEG Complaint instead. 
 
If you want to use any of the frames of a project in other programs you can also use 
the Export as HTML option but just use the exported images in the chosen format 
and ignore/delete the corresponding HTML file. 

3.9 Project Information  
 
You can get some information about the current project using menu 
“ProjectàInformation”. 

3.10 Preferences 
 
Wink’s preferences can be found in the menu “FileàPreferences” where you can 
specify some general settings for the program. 

3.11 Toolbar 
 
Here is a list of all the icons in Wink’s toolbar and what they do. 
 

 Create a new project 

 Open an existing project 

 Save the active project 

 Wink preferences 
 Delete the current selection 
 Cut the current selection and put it on the Clipboard 
 Copy the current selection and put it on the Clipboard  
 Paste Clipboard contents 

 Move to the first frame in the sequence 

 Move to the previous frame in the sequence  

 Move to the next frame in the sequence 

 Move to the last frame in the sequence  
 View/modify the palette for the current project 
 View/modify settings for the current project 
 Render the presentation from this project with the given options 

3.12   Shortcut keys 
 

F3 Project Settings 
F4 Program preferences 

Ctrl + F4  Close project 
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F3 Project Settings 
F6 / Alt + F6  Switch between thumbnail and work-area panes 

Ctrl + F6  Switch between open projects 
F7 Render Project 

Ctrl + A  Select all elements in a frame or select all frames 
Ctrl + E  Edit Textbox 
Ctrl + F  Choose Textbox Font 
Ctrl + I Edit Title  

Ctrl + L Choose Callout 
Ctrl + N New project 
Ctrl + O  Open existing project 
Ctrl + P  Edit Palette  
Ctrl + R  Choose Cursor 
Ctrl + S  Save project 
Ctrl + T  Apply Template 
Ctrl + Y  Redo 
Ctrl + Z Undo 

Insert Insert Frames 
Delete  Delete  

Ctrl + X / Shift + Del Cut 
Ctrl + C / Ctrl + Ins Copy 

Ctrl + Shift + C  Copy Merged  
Ctrl + V / Shift + Ins Paste 

Alt + Ctrl + ß First frame 
Alt + ß Previous frame 
Alt + à Next frame 

Alt + Ctrl + à Last frame 
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4   

4.1 Screen size of presentations 
 
When creating presentations you should think about what screen resolution the end 
users are likely to use. If the user views the flash file inside the browser they won't be 
able to see the entire area if the flash file is the same size as the end users screen 
resolution. Also the taskbar takes up some screen space. Therefore you should 
always be sure to record the presentation in a smaller size than the screen resolution 
the targeted users are likely to use. 
 
For instance if you make a presentation based on the entire screen size and you 
know that the end users are like to use a screen resolution of 1024*768, then set 
your screen resolution (temporarily) to 800*600 when doing the capture. Afterwards 
when editing inside Wink you can return to the normal (larger) resolution because 
then you will be able  to see the entire (or at least most of the) area of each frame, 
which makes it easier to edit the project. 

4.2 How often to capture screenshots 
 
To make presentations look as natural as possible you should take a screenshot 
each time you have moved the mouse (this is often the hardest to remember), 
marked something with the mouse or keyboard, opened/closed something with the 
mouse or keyboard and typed something with the keyboard. In the end some editing 
of the presentation is necessary to make the flash file look correct. 
 
When the mouse cursor changes to another pointer between the start and end 
position of a movement (for instance from the normal arrow to a text select pointer) 
you might also want to take an extra screenshot when the mouse cursor is at the 
exact position where it has changed to the new pointer.  

4.3 Edit multiple frames 
 
One of the cool features of Wink is that you can edit the properties of multiple frames 
simultaneously. If you select more than one frame/thumbnail in the sequence the 
options changed in the properties bar apply to all frames. So you can change the 
textbox font used in all marked frames and even more interesting when using the 
advanced properties bar it is possible to align the position of, for instance, the Next 
button across all selected frames by editing the position values in the properties bar. 
 
 

4 TT IIPPSS  AANNDD  TTWWEEAAKKSS  
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4.4 Insert image files into frames 
 
You can  insert normal image files into frames in Wink by opening the images in an 
image browser or paint program, copy the image to clipboard inside th is program and 
then paste it into a frame in Wink. So if you have captured some screenshots in 
another program it will be possible to insert this into a Wink project and you can also 
use non-screenshot images like photos. 

4.5 How to create more than one textbox in a frame 
 
Normally a frame can have only one textbox but it is possible to achieve the effect of 
having two or more textboxes by using the Copy Merged option (even though only 
the ‘real’ textbox will be editable). 
 
To do this you must select the frame that you would like to have two (or more) 
textboxes in, temporarily disable all elements except the textbox, choose menu 
“EditàCopy Merged”, paste the new image into the same frame and enable the 
previously disabled elements. Then move the textbox and you should now see a 
copy of it below the original. The copy cannot be changed because it is part of the 
image. But the original textbox can be edited as needed and you achieve the effect of 
having two textboxes. To get even more textboxes you will just have to repeat this 
procedure. 
 
Be aware that if you are currently using a background image/color in the project you 
will have to remove the background image/color temporarily and add it again 
afterwards. 

4.6 Copy frames between projects 
 
You can open more than one project simultaneously in Wink and copy frames 
between projects. This way if you have created a project but you forgot to take some 
more screenshots you can create the remaining screenshots in a new project and 
copy these frames to the old project. 

4.7 Optimize the size of presentations 
 
To optimize the file size of presentations you should clean your desktop before 
capturing screenshots. This also has the advantage that the end users seeing the 
presentation won't be distracted by other things you might have installed on your 
computer. Some of the things to clean up are: 
 

• Remove unnecessary icons from the desktop (copy them to a folder to easily 
get them back). 

• Disable wallpaper and use a single color on the desktop. 
• In Windows XP set the theme to “Windows Classic” instead of the default 

“Windows XP”. 
• Set the title bar of windows to a single color instead of the default gradient. 
• Disable the Quick Launch toolbar. 
• Close all non-relevant programs (also in the system tray). 

 
If you won't be showing the desktop or taskbar in the presentation some of these 
suggestions obviously aren't necessary. 
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4.8 Maximize the space for showing presentations in a 
browser 

 
To be sure that the end users can see the entire (or at least most of the) presentation 
area you can disable all the elements that usually show in the browser like the 
toolbar, address bar, status bar etc. using JavaScript to open the new browser 
window. 
 
If you have a webpage from which the Wink-generated presentations are showed, 
add the following script code somewhere inside the <head></head> element of that 
webpage html source. 
 

 
<script> 
function WinkPresentation(file) 
{ 
    window.open(file,'Wink','resizable=1,scrollbars=1'); 
} 
</script> 
 

 
The actual link that will open the html file with the presentation must be added inside 
the <body></body> element of the html source. For example: 
 
 

 
<a href="javascript:WinkPresentation('sample.htm');"> 
    Show sample presentation 
</a>  
 

 
In the example above “sample.htm” must be replaced with the name of the html file 
generated by Wink and  ”Show sample presentation” should be replaced with the text 
you want the user to see in the homepage describing the presentation: 

4.9 Saving compressed projects  
 
Wink projects can take a lot of space if they have a large number of frames, since all 
of them are image/video data. When you have finished a project or if you want to 
send a project to a friend, it is a good idea to save the project using “File > Save 
compressed” menu option. This will compress the project and save. Compressed 
projects typically occupy 4 times to 20 times lesser space than normal projects. You 
can compress them further using any zip utility. 
 
Compressing projects and loading compressed projects take a significant time, so 
use this only when necessary. All samples distributed with Wink are compressed 
projects. 
 

4.10 URLs of interest 
 
DebugMode homepage – http://www.debugmode.com/ 
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Wink homepage – http://www.debugmode.com/wink/ 
DebugMode User Forums – http://www.debugmode.com/forums/ 
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5   

5.1 Buttons in PDF files exported from Wink 
 
When using Continuous view in Adobe Acrobat Reader all buttons in a PDF file 
exported from Wink will go to the page/frame after the actual frame they should go to. 
The buttons work correct when Adobe Acrobat Reader is setup to the default Single 
Page view. This is an issue with Acrobat Reader and not Wink and hopefully will be 
corrected in future releases of Acrobat Reader. 
 

5.2 Flash output sometimes looks garbled with palette  
 
This is due to a bug with the Flash player. You can either render the flash output 
without a palette, or create another palette with different number of colors to work 
around this bug. 
 
 

5 KKNNOOWWNN  IISSSSUUEESS  


